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Green Arrows:    The single arrows will move through the data one record at a time.
                                                  The double arrows will page through the data file four records at a 
time.



    
The File Menu

The File Menu allows for creating, maintaining, and printing. It has the following options:

         New                    Create a new database file.
         Open                  Open a database file.
          Save                  Save the current database file.
          Save_As      Save the current database to a new file.
         Print                    Print Address book, Labels, Envelopes.
         Import              Insert records into the database.
         Export             Export records to a file.
         Exit                      Exit Address Book.



File New Menu

This selection will close the current database file and prepare for entering data into a new 
database file.



File Open Menu

This selection will present the open file dialog box for selecting an exisiting database file to be 
load.



File Save Menu

This selection will save changes made to the current database file.



File Save_As Menu

This selection will present the save file dialog to allow saving a current database to a new file.



File Print Menu

This selection will present a variety of printing options:

          Phone List Two Columns (Name and Number Only)
         Phone List (Condensed Name/Address/Phone)
          Pocket Size Address Book
         2-Up Labels 1 x 4 inches
          3-Up Labels 1 x 2-5/8 inches
          #10 Business Envelope: 4-1/8 x 9-1/2 inches
         Monarch    Envelope: 3-3/4 x 7-1/2 inches
          #6 Personal Envelope: 3-3/4 x 6-1/2 inches



Phone List Two Columns (Name and Number Only)

This will only the names and phone numbers in an easily read two column format.    A dialog box
is presented that lets you enter the Title of the list, fonts to be used, and Selection_Flags to print 
only the names of interest.



Phone List (Condensed Name/Address/Phone) 

This print selection    trys to cram the Name, Address, and Phone numbers on a single line. 
Names and address may be truncated at times if it can not all be displayed. The font size used for
the address will be reduced to squeeze it in the allowable space.    A dialog box is presented that 
lets you enter the Title of the list, fonts to be used, and Selection_Flags to print only the names of
interest.



Pocket Size Address Book

My desire to have a small address book prompted me to write this program. This selection will 
print in quadrants on the paper, and it will be done a fashion    that when cut and folded will 
produce an address book with dimensions of 4-1/4    x 5 -1/2 inches. The easiest way to see how 
this is accomplished to simply give it a try. 

You will first be given a dialog box to choose fonts to be used, and Selection_Flags to print only 
the names of interest.    After you select print, and you printer stops you are only half way 
through with print job. A dialog box will appear asking you to remove the printed sheets and 
reinsert into the printer to print on the reverse side.    After doing this press OK to continue to 
print the second half. 

When the second stage of printing has complete set the sheets of paper down so that the quadrant
with the page number 1 is face up.    It will be in the upper right hand corner. Next cut the paper 
in half.    Now if you let the paper lie as it was before you made the cut,    simply reach up and 
grab all of the sheets    in the pile that has quadrant page number 1. Place this stack on top of the 
other stack.    The last step is to pick all the sheets up, fold them back, hit them with a staple and 
it is done.



2-Up Labels 1 x 4 inches

This printer selection will print standard    1x4 inch labels. There will be two across and 10 down 
for a total of 20 per page.    A    dialog box will permit the font choice and Selection_Flags to 
print only the names of interest.



3-Up Labels 1 x 2-5/8 inches

This printer selection will print standard    1x2-5/8 inch labels. There will be three across and 10 
down for a total of 30 per page.    A    dialog box will permit the font choice and Selection_Flags 
to print only the names of interest.



Envelope Printing

This printer selection will print an envelope for the person whose name had the turquoise 
selection from the graphical address book. A dialog box will be presented that allows separate 
font choices and point size for the return address as well as the addressee. In addition you can 
select different point sizes for the first line of the return address and addressee. The Post Net 
code can be printed as well as a Note Line. 

The return address pulled into the dialog box comes from entries previously made in the Options 
Report Header dialog box. It was here that you could enter two possible return addresses. The 
two check boxes below the return address field labeled #1 and #2 will toggle between the two 
previously defined return addresses.    The edit box containing the return address can always be 
edited to change any or all text in the return address.

The addressee information was pulled from the turquoise selection from the graphical address 
book.    The work or home check boxes determine which address to use. The edit box containing 
the addressee can always be edited to change any or all texts in the addressee.

The Post Net code for the zip code can be printed.    The zip code that will be used for the Post 
Net is displayed in a special field.

To put a note on the envelope you need to select the NOTE button. This brings up a dialog box 
that lets you select from some predefined text strings, or you can edit your own. You may also 
select the font and point size for the note text string. 



Address Book Features

This section describes the features of the Address Book Graphics Display and Name List Box.    

The Address Book area permits navigation by using Tabs and Arrows. Clicking on the 
Alphabetic Tabs will take you to the first record whose last name begins with that letter. If there 
is no name starting with that letter no movement will be made. Clicking on the Green Arrows 
moves sequentially foreward or backward through the records. The single arrow will move one 
record while the Double Arrows will page through four records per time.

The Address Book area is also used to determine the active record. The active record is the one 
highlighted in turquoise. To highlight the record of interest simply click on the name in the 
Address Book. The active record will be the one used if you click on the Edit Button or select 
Edit from from the pull down menu. Double Clicking on the name highlighted in Turquoise will 
also cause the Edit dialog box to pop up for that record. The active record will also be the record 
used when you choose to print an envelope.

The List Box is the fastest way to locate the person you are interested in.      the name in the edit 
portion of the List will immediately highlight that person in the Address Book display. 

By using the scroll bars you can easily look at the names in your database. Clicking on a name in
the scroll area will make it the Active record. Double Clicking on a name in the scroll area will 
call up the dialog box for making modifications to the record.



Import

This selection will insert into the database a file that was previously exported. This simply adds 
the entries of the export file to the current database.



File Export

This selection will write the selected database records as ASCII strings to a specified file. The 
fields are contained in quotes and separated by commas. Exporting and Importing files is a 
method that can be used to merge database files. 

When the export command is given, it will only export records currently selected as indicated by 
the flag field. By using the flags field you manipulated which records will be exported.

The address book fields are written out in the following order:
LastName, FirstName, Title, ID, HomePhone, WorkPhone, Fax, Phone4, HomeAdr1, 
HomeAdr2, HomeAdr3, HomeState, HomeZip, WorkAdr1, WorkAdr2, WorkAdr3, WorkState, 
WorkZip, Birthday, EntryDate, Flags, FreeText.



File Exit

Exit the Adr_Book program.



Edit_Menu

The Edit Menu manages the database file through Adding, Deleting, and Editing.

            Add              Create a new record.
           Delete      Delete a record.
           Edit              Modify a record.



Adding and Editing

Adding or Editing goes to a dialog that lets you do exactly what you would expect. The only 
point of interest is a dialog button that says "Add / Next".    If you have entered the dialog box for
Adding, "Add / Next"    will cause the record to be added and present you with cleared fields to 
allow entering of another record. If entered for Editing the "Add / Next" will bring up the next 
sequential record for editing.



Delete

Selecting Delete will bring up a dialog box asking if you really want to delete this record. The 
record to be deleted will be the one currently highlighted in turquoise.



Options Menu

This menu permits setting configuration items.

          Display                            What will be displayed on the Address Book.
          Report Header      Titles and Return Address for printing.



Report Header

The dialog box presented allows you to enter two text lines that will be used at the top of printed 
reports.    This is also the place where default return addresses are entered for use when printing 
envelopes.    



Display

The dialog box presented allows choosing what information will be displayed on the graphical 
address book.    Because there is limited room on the display not all record elements can be 
displayed. Additionally, you can specify which records will be displayed by using the flag fields.



Flags

Entering codes in the Flags Field permits printing, exporting, and displaying records of particular
interest.    The operations that can be used with the Flags are OR, AND, SEQ, and NOT. Listed 
below are explainations of how you would enter codes in the dialog boxes for printing, exporting
or displaying records.

The OR option will select all records that have any of the codes you list in flags field. Imagine 
you entered a flag code of T for friends that play Tennis and an R if they like to play 
Racquetball.    Now if you felt like playing Racquetball or Tennis and wanted to find people who 
might be interested in either of these sports,    in the flags field of the dialog box you would put 
TR and then select the OR check box.

The AND option will only select records if all codes listed are present in the flags field for a 
record. Imagine you needed to find a woman to fill out a golf foursome. If you used the codes F 
for female and G for golfers, you would enter an FG in the in the flags field of the dialog box 
and then select the AND check box. 

The SEQUENCE option will only select records that have a matching string of characters.    If 
you used words like JULY and MARCH to represent the month of individuals birthdays, 
entering the word JULY in the flags field of the dialog box and then selecting the Sequence 
check box would list people with birthdays in July.

The NOT check box reverse the sense of the match. In the example above for finding July 
birthdays, if the NOT check box was also selected you would have a list of all people who did 
not have a birthday in July.



Registration

Registering ADR_BOOK
First of all, if you find this program useful that's GREAT!    I would like to hear from you on any 
suggestions you have, no matter how trivial. We have long cold winters in Alaska that can be usd
for program enhancements.    Feel free to write to my address below or send Internet E-mail to 
mikeg@ims.alaska.edu.

If you have decided that you like ADR_BOOK and would like to register, please send a check 
for $15 in US funds to:

                    Michael Gardner
                    1231 Redwood Ct.
                    Anchorage,    AK    99508

I will promptly send you the latest software revision.

Here is an Order Form you can print and use:

Please send the registered version to:

Name:

Address:

Zip Code

Please ship me _____    copy(s)    of    Adr_Book 

Total Price:    ______

Any Suggestions:



More Than 50

I really do wish you would register.    You would feel better.    You would be helping the Alaska 
Software Industry (which is basically non-existant)

Though you can not ADD more than 50 records to a database file, you can import additional 
records to create a file containing more than 50 records. Use the following steps:

1. Save your current file with 50 (or more) records

2. Select NEW from the FILE menu at the top of the window.

3. Select ADD to enter any new records.

4. Select EXPORT from the FILE menu. Save to file TMP.DMP

5. Select OPEN from the FILE menu to retrieve your original database file. ( When asked if you 
want to save changes to the current database file - Just say NO)

6. Select IMPORT from the FILE menu and retrieve TMP.DMP.

That's All.




